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Abstract

Optical control of protein function through proteasomal degradation benefits from the
noninvasive nature and spatiotemporal precision of light as a trigger. In this chapter,
light activation of protein degradation with an optically controlled degron, termed
optoDeg, is discussed. This method utilizes genetic code expansion to insert a photo-
caged analog of lysine at the N-terminal position of a protein of interest for spatial and
temporal control of the N-end pathway, inducing proteasomal degradation. Methods
for the use of optoDeg for degradation of the fluorescent reporter EGFP and the kinase
MEK1 are described. The system is fast, with complete degradation of proteins within
minutes following irradiation, and highly specific, with genetically directed introduction
of the light-activated degron.
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1. Introduction

Our new optically controlled degron, or optoDeg, utilizes a small

peptide degron, comprised of 14 amino acids with an N-terminal photo-

caged lysine, genetically fused to the protein of interest (POI). The small size

prevents perturbation of the function of the POI, until a brief irradiation

triggers fast POI degradation within seconds to minutes (Ryan, Liu, &

Deiters, 2021). Degradation can be controlled with high temporal and

spatial resolution using light as an external trigger and degradation is

completely specific for the POI. Furthermore, only minimal protein engi-

neering is required and the approach has broad applicability to a variety of

POIs, as we have demonstrated optically activated degradation of a fluores-

cent reporter (EGFP), a bioluminescent reporter (firefly luciferase), a kinase

(MEK1), and a phosphatase (MKP3).

The optoDeg design was inspired by theN-end rule, which describes the

relationship of the N-terminal residue to the in vivo half-life of a protein

(Varshavsky, 2011) through recruitment of the ubiquitin-proteasome

machinery. Destabilizing N-terminal residues, or N-degrons, are exposed

via proteolytic cleavage by proteases such as caspases, separase, and calpains

(Varshavsky, 2008). Primary N-degrons, classified as either Type 1 (Arg,

Lys, His) or Type 2 (Phe, Leu, Trp, Ile, Tyr) recruit endogenous E3 ligases

to ubiquitinate the protein and ultimately label it for proteasomal degrada-

tion (Sriram, Kim, & Kwon, 2011).

Replacement of an N-degron residue with a photocaged unnatural

amino acid (UAA) via genetic code expansion allows for minimal perturba-

tion of protein function while introducing spatiotemporal control by using

light as an external regulatory element (Ankenbruck, Courtney, Naro, &

Deiters, 2018; Courtney & Deiters, 2018). UAA mutagenesis utilizes an

engineered aminoacyl tRNA synthetase to acylate a cognate tRNA with

the specified UAA. The UAA is then inserted into the POI in response

to a recoded amber stop codon (UAG), catalyzed by the ribosome (de la

Torre & Chin, 2021). Genetic incorporation of a photocaged lysine analog,

such as hydroxycoumarin lysine (HCK), in place of the N-terminal residue

results in steric and electrostatic disruption of N-degron recognition by the

E3 ligase. Following a brief irradiation, the optoDeg is decaged, yielding

the destabilizing lysine for E3 ligase recruitment and the subsequent

ubiquitination and degradation of the POI (Fig. 1). Other examples of con-

trolling protein-protein interactions with light using genetic code expansion
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are still rare and include a caged phosphatase (Courtney & Deiters, 2019), a

caged nanobody ( Joest, Winter, Wesalo, Deiters, & Tamp�e, 2021), nuclear
localization sequences (Engelke, Chou, Uprety, Jess, & Deiters, 2014;

Gautier et al., 2010), and protein SUMOylation (Wesalo, Luo, Morihiro,

Liu, & Deiters, 2020). Additionally, optical control of chimeric protein

degraders, or PROTACs, has been achieved through insertion of photo-

switchable azobenzene linkers ( Jin et al., 2020; Pfaff, Samarasinghe,

Crews, & Carreira, 2019; Reynders et al., 2020) and through the control

of critical protein-small molecule interactions with bulky, light-cleavable

caging groups (Liu et al., 2020; Naro, Darrah, & Deiters, 2020; Xue,

Wang, Zhou, Zhong, & Pan, 2019).

Due to ribosomal infidelity in the early steps of mRNA translation,

amber stop codon suppression and resultant incorporation of photocaged

UAAs at the N-terminal region of a POI can have decreased efficiency.

This obstacle for genetic code expansion pertaining to the N-terminus of

a protein has been overcome using a ribosomal skipping site ( Joest,

Winter, Wesalo, Deiters, & Tamp�e, 2022). As a complementary approach,

we utilized an N-terminal ubiquitin that is cotranslationally cleaved by

deubiquitinases (L�evy, Johnsson, R€umenapf, & Varshavsky, 1996) to gen-

erate a POI that contains an N-terminal UAA, the caged lysine HCK.

Fig. 1 Light-inducible N-degron design. Residue X (A, K, or HCK) is linked to the POI with
a 13-residue peptide linker. The optoDeg containing HCK can be activated via light stim-
ulation to induce E3 ligase recruitment for polyubiquitination and proteolytic degrada-
tion of the POI. The shown protein structure depicts the E3 ligase UBR bound to a
peptide substrate bearing an N-terminal lysine (purple). Dotted lines represent electro-
static interactions between the lysine and the negatively charged aspartic acid residues
in the UBR box (gray).
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Here, we are describing the application of the optoDeg approach for the

optical control of protein function. Using an optimized peptide degron of

just 14 amino acids attached to the N-terminus of the POI, the optoDeg

approach can easily be applied to any protein target. The extent of POI deg-

radation can be validated through simple and accessible western blot analysis

of protein expression before and after irradiation. Further, the degradation of

fluorescently labeled POIs can be monitored via fluorescence microscopy.

We first describe the validation of the optoDeg technique through optical

control of EGFP expressed in cellulo. We then present an example of

optoDeg for the control and monitoring of cell signaling cascades. To dem-

onstrate this, constitutively active MEK1, a protein kinase central to the

Ras/MAPK signaling pathway, can be expressed with an appended

optoDeg peptide. The active MEK1 phosphorylates serine/threonine

kinases ERK1 and ERK2, inducing nuclear translocation and proliferation

of the Raf/Ras pathway. Once MEK1 is degraded, ERK2 is not phosphor-

ylated and thus remains localized to the cytoplasm.

2. Materials and equipment

2.1 Materials
1. EcoRI restriction enzyme (NEB R3101S)

2. BamHI restriction enzyme (NEB R0136S)

3. Antarctic phosphatase enzyme (NEB M0289L)

4. Antarctic phosphatase reaction buffer (10�, NEB M0289L)

5. Agarose, low EEO (Fisher BP160)

6. Ethidium bromide (CAS 1239-45-8, Thermo Scientific AC17096)

7. T4 Ligase (NEB M0202S)

8. rCutSmart Buffer (10�, NEB B6004S)

9. DMSO

10. dNTP mix (Fisher FERR0181)

11. Phusion polymerase kit (Thermo Scientific F350L)

12. DpnI (NEB R0176S)

13. GeneJET Gel Extraction Kit (Thermo Scientific FERK0692)

14. GeneJET PCR Purification Kit (Thermo Scientific FERK0702)

15. Gibson Master Mix (Gibson et al., 2009)

16. Top10 chemically competent cells

17. Agar (Fisher BP1423-2)

268 Olivia Shade et al.



18. Tissue culture dish, 100�20mm (Fisher 353,003)

19. Kanamycin (CAS 25389-94-0, VWR 100217-492)

20. LB broth (Fisher BP1426-2)

21. GeneJET Plasmid Miniprep Kit (Thermo Scientific K0503)

22. HEK293T cells (ATCC CRL-11268)

23. NIH 3T3 cells (ATC CRL-1658)

24. Poly-D-lysine hydrobromide (Fisher ICN15017550)

25. 12-Well plate (Greiner 665180)

26. 96-Well plate (VWR 82050-748)

27. Hydroxycoumarin lysine (HCK, 50mM in DMSO) (Luo et al., 2014)

28. pE323-HCKRS (Schmied, Els€asser, Uttamapinant, & Chin, 2014)

29. Dulbecco’sModified EagleMedium (DMEM), 10% fetal bovine serum

(Sigma-Aldrich, F0926)

30. Penicillin/streptomycin (Cytiva SV30010)

31. Opti-MEM transfection media (Gibco, 22600-050)

32. Linear polyethyleneimine (LPEI, Polysciences, 23966)

33. Lipofectamine 3000 and P3000 (Invitrogen, L3000008)

34. Buffers

a. 1� TBE (10.8% (w/v) tris base, 5.5% (w/v) boric acid, 4% (v/v)

0.5M EDTA (pH 8.0), in milliQ water)

b. 1� SDS buffer (0.3% (w/v) tris base, 1.44% (w/v) glycine, 0.1%

(w/v) sodium dodecyl sulfate, in milliQ water)

c. 1� Transfer buffer (0.3% (w/v) tris base, 1.44% (w/v) glycine, in

milliQ water)

d. 1� PBS (0.256% (w/v) Na2HPO4�7H2O, 0.8% (w/v) sodium

chloride, 0.2% (w/v) potassium chloride, 0.2% (w/v) KH2PO4,

in milliQ water)

e. RIPA buffer (50mM Tris-HCl, pH 8.0, 150mM sodium chloride,

1% (v/v) NP-40, 0.5% (w/v) sodium deoxycholate, 0.1% (w/v)

sodium dodecyl sulfate) supplemented with 1� Protease inhibitor

(Thermo Scientific 78429)

f. 4� SDS-PAGE sample loading buffer (2mL of 1M Tris-HCl

(pH 6.8), 0.8g sodium dodecyl sulfate, 4mL glycerol, 400μL
B-mercaptoethanol, 8mg bromophenol blue, 4mL milliQ water)

g. 10� TBS (1.21% (w/v) tris base, 8.76% (w/v) sodium chloride, in

milliQ water)

h. TBST (100mL 10� TBS, 1g Tween-20, 1L milliQ water, stored

in fridge)

i. 5% Milk (Fisher NC9121673) in TBST
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35. Antibodies

a. rabbit pAb anti-GFP (ProteinTech 50-173-5832)

b. rabbit pAb anti-GAPDH (ProteinTech 50-172-6351)

c. rabbit pAb anti-HA (Cell Signaling 3724S)

d. anti-rabbit IgG HRP-linked secondary antibody (Cell Signaling

7074S)

36. PDVF membrane (0.45μm, Millipore, IPVH00010)

37. PageRuler Prestained Protein Ladder (Thermo Scientific PI26617)

38. SuperSignal West Pico Chemiluminescent Substrate (Thermo

Scientific 34580)

39. Live cell imaging solution (LCIS, Invitrogen, A14291DJ)

40. Phenol red-free DMEM (Cytiva, SH3028401)

41. Aluminum foil

42. Cycloheximide (Acros, 357420010)

43. Fibroblast Growth Factor (FGF, Gibco PHG0264)

2.2 Equipment
1. PCR thermocycler (T100 Thermal Cycler, Bio-Rad)

2. Incubator (VWR, Symphony)

3. Shaker (New Brunswick Scientific, Excella E24 Incubator Shaker

Series)

4. Sterile laminar flow hood (ThermoFisher Scientific, 1300 Series A2)

5. Water jacketed CO2 incubator (HEPA class 100, Forma Series II,

Thermo Electron Corporation)

6. Transilluminator (VWR Dual Transilluminator)

7. LED (405nm, Mouser, LZ1-10UB00-01U7)

8. Electrophoresis power supply (Power-Pac 1000, Bio-Rad)

9. Electrophoresis chamber (Bio-Rad)

10. ChemiDoc Imaging System (Bio-Rad)

11. Zeiss Axio Observer Z1 with an AzioCam MRm camera and Plan-

Apochromat 10�/0.45 objective and Plan-Neofluar 40� objective

a. FITC filter set (38 HE, Ex. BP 470/40, Em. BP 525/50)

b. dsRed filter set (43 HE, Ex. BP 550/25, Em. BP 605/70)

12. Tokai Hit incubated stage (Inu)

13. ZEN 2 (blue edition) software package (Zeiss)

14. ImageJ software (National Institutes of Health)
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3. Step-by-step method details

3.1 Plasmid construction: pUb-X-EGFP-P2A-mCherry
Timing: 4–5 days

3.1.1 Digest the backbone of pEGFP-HA (8000ng in 43μL of water and

5μL of 10� rCutSmart Buffer) with 1μL of EcoRI and 1μL of

BamHI restriction enzymes for 3h at 37 °C
3.1.2 Prevent ligation of the linearized backbone by combining 44μL of

the digested backbone with 5μL of 10� Antarctic phosphatase

buffer and 1μL of Antarctic phosphatase enzyme. Incubate for 1h

at 37 °C
3.1.3 Run the digested product (50μL) on a 0.8% agarose gel containing

ethidium bromide (80V for 20–30min) in 1� TBE. Identify the

band corresponding to the�4500bp backbone through brief expo-

sure on a transilluminator, then cut out the band, taking care to

excise only the band of interest without excess agarose. Extract

the backbone from the gel using the GeneJET Gel Extraction Kit

following the manufacturer’s protocol

3.1.4 PCR amplify the Ub insert from the pET-Ub plasmid (Braxton,

Quartner, Pawloski, Fushman, & Cropp, 2019): 2μL of 10ng/μL
template DNA, 20μL of 5� GC buffer, 3μL of DMSO (to reduce

secondary structures and increase primer annealing (Varadharajan &

Parani, 2021)), 2μL of 10mM dNTP mix, 2μL of a solution con-

taining 10μMeach of the primers P1 and P2 (Table 1), 70μL ofwater,
and 1μL of Phusion polymerase (added last) with total volume of

100μL. For the thermocycler settings, use an annealing temperature

of 67.8°C and an elongation time of 30s. DpnI treat the PCR prod-

uct for 1h with 0.5μL of DpnI and 5μL of 10� rCutSmart Buffer

Thermocycler settings:

1. Initial denature step at 95 °C for 3min—1cycle

2. Denature at 95 °C for 30 s, then anneal at 5°C below the

primer melting temperature for 30 s, then elongate at 72°C
for 30 s per kilobase—29cycles

3. Final elongation step at 72 °C for 10min—1cycle

4. Cool to 12 °C for 10min

3.1.5 Digest the insert PCR product by diluting 43μL of the PCR with

and 5μL of 10� rCutSmart Buffer. Add 1μL each of EcoRI and
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BamHI restriction enzymes and incubate the mixture for 2h at

37 °C. Purify the entire PCR product using the GeneJET PCR

Purification Kit following the manufacturer’s instructions

3.1.6 Combine 1 equivalent (around 100ng) of the backbone from step

3.1.3 with 10M equivalents (about 50ng) of the insert from step

3.1.5, keeping total DNA volume under 8.5μL. If necessary, add
water to bring the volume to 8.5μL. Combine the DNA mixture

with 1μL of T4 DNA Ligase buffer, and 0.5μL of T4 DNA ligase.

Ligate by incubating overnight at 16°C. This will yield the pUb-

K-EGFP-HA plasmid

3.1.7 Perform site directed mutagenesis via PCR with 1μL of template

DNA (10ng/μL), 10μL of 5� GC buffer, 1.5μL of DMSO, 1μL
of 10mM dNTP mix, 0.5μL of Phusion polymerase (added last)

with 1μL of forward and reverse primers (P3 and P4, respectively,

Table 1 Primer list.
P1 gcggaattcaccatgcagatttttgtgaaaacc

P2 gcgggatcctgtcgaccaagcttgccgccacgcagacgcagc

P3 gcgtggcggcgccggcggccttggtcgacaggatcc

P4 caaggccgccggcgccgccacgcagacgcagcacc

P5 gcgtggcggctagggcggccttggtcgacaggatcc

P6 caaggccgccctagccgccacgcagacgcagcacc

P7 gagctgtacaagtcaggaagcggagctactaacttcagc

P8 agcggccgcgactctagatcataatcagccata

P9 agcggccgcgactctagatcataatcagccata

P10 gggatcactctcggcatggacgagctgtacaag

P11 gtcgccaccgccccgaagaagaaaccgaccccgatccagctg

P12 cccgacccacgctgctggtgtgtacccatacgatgttccagattacgcttaatgataaagcggccgcgactct

P13 cacgctgctggtgtgtacccatacgatgttccagattacgcttaatgataaagcggccgcgactctagatcat

aatcag

P14 gacagaagccaccggtcgccaccccgaagaagaaaccg

P15 cgcaaatgggcggtaggcgtg

P16 cgtcgccgtccagctcgacca

P17 catggtcctgctggagttcgtg
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each diluted to 10μM in 10μL of water) to create pUb-A-

EGFP-HA. Repeat the same PCRwith primers P5 and P6 to create

pUb-TAG-EGFP-HA. Conduct each PCR with an elongation

time of 3min and an annealing temperature of 57°C. DpnI treat

the PCR product for 1h with 0.5μL of DpnI and 5μL of 10�
rCutSmart Buffer

3.1.8 Amplify the P2A-mCherry gene from pWnt3A-P2A-mCherry

(unpublished) using primers P7 and P8, an annealing temperature

of 59.8 °C, and an elongation time of 30 s using the thermocycler

settings from step 3.1.4. Amplify the pUb-X-EGFP backbone with

primers P9 and P10 using an annealing temperature of 60.5 °C and

an elongation time of 2.5min

3.1.9 Anneal the amplified P2A-mCherry insert from step 3.1.8 and the

pUb-X-EGFP backbone from step 3.1.6 following the published

Gibson assembly protocol (Gibson et al., 2009). This will yield

the pUb-X-EGFP-P2A-mCherry plasmid (Fig. 2)

Fig. 2 Plasmid maps depicting pE323-HCKRS, pEGFP-ERK2, pUb-X-EGFP-P2A-mCherry,
and pUb-X-caMEK1-HA-P2A-mCherry. The pE323 HCKRS was selected for encoding HCK
because of its superior incorporation efficiency for UAAs (Zhou, Wesalo, Liu, & Deiters,
2020). X indicates the position of the key residue for optoDeg design: stabilizing A,
destabilizing K, or optoDeg HCK.
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3.1.10 Thaw Top10 competent cells (50μL) on ice for 3–5min, then add

5μL of the DNA product to the cells under a flame. Incubate the cells

on ice for 30min, then heat shock at 37°C for 30–45s. Return the

cells to ice and incubate for 2min. Under sterile conditions, add

200μL of SOC media to the cells. Incubate with agitation for

45min at 37°C. Use 4–8 Rattler Plating Beads to spread the mixture

evenly on a freshly prepared agar plate containing 50μg/mL kanamy-

cin in 10mL of agar. Incubate the plate overnight at 37°C. The fol-
lowing day, inoculate a single colony into LB broth containing

50μg/mL kanamycin by scooping the selected colony with a sterile

pipet tip and dropping the tip into the LB broth mixture (5mL).

Incubate the inoculated colony with shaking for 16–20h at 37°C
3.1.11 Pellet the cells via centrifugation (4500 g for 10min), then isolate

the DNA using a GeneJET Plasmid Miniprep Kit

3.1.12 Confirm the DNA sequence with Sanger sequencing (Genewiz).

Use universal primers CMV forward (P15), EGFP-N reverse

(P16), and EGFP-C (P17) to sequence the plasmid

3.2 Plasmid construction: pUb-X-caMEK1-P2A-mCherry
Timing: 3–4 days

3.2.1 PCR amplify the caMEK1 insert from the pMEK-DD-HA plasmid

(Gautier, Deiters, & Chin, 2011) using primers P11 and P12, an

annealing temperature of 61.5 °C, and an elongation time of 1.5min

3.2.2 Amplify the pUb-X-P2A-mCherry backbone from pUb-X-EGFP-

P2A-mCherry (from step 3.1.9) with primers P13 and P14, with

annealing temperature 61.5 °C and a 2.5min elongation time

3.2.3 Assemble the plasmid using 75ng of the backbone from step 3.2.2

and 3M equivalents of the insert from step 3.2.1, using 15μL of

Gibson Master Mix (add water to bring the final volume to

20μL). This will yield the pUb-X-caMEK1-P2A-mCherry plasmid

(Fig. 2)

3.2.4 Transform and inoculate the DNA product from step 3.2.3 in Top10

competent cells as described in step 3.1.10

3.2.5 Pellet the cells via centrifugation (4500 g for 10min), then isolate the

DNA with the GeneJET Plasmid Miniprep Kit following the man-

ufacturer’s protocol

3.2.6 Confirm the DNA sequence as described in step 3.1.12
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3.3 Western blot validation of optically controlled pUb-
X-EGFP-P2A-mCherry

Timing: 6–7 days

3.3.1 Dilute 65μL of poly-D-lysine hydrobromide (PDK, 10mg/mL)

into 6435μL sterile water. In a laminar flow hood, add 500μL of

the PDK mixture to each well of a 12-well plate. Incubate the plate

at room temperature for 10–20min, then aspirate the PDKmixture.

Wash each well with 500μL of sterile water, then allow the plate to

air dry for 45–60min before plating cells in DMEMcontaining pen-

icillin and streptomycin antibiotics

3.3.2 Grow HEK293T cells to 80–90% confluency in a water jacketed

CO2 incubator at 37 °C
3.3.3 For wells where cells will express plasmids without a TAG mutant,

gently lift the old media and replace it with 900μL of fresh,

prewarmed (37 °C) antibiotic-free DMEM

3.3.4 For wells where cells will express plasmids containing a TAG

mutant, gently remove the old media and replace it with 900μL
of prewarmed (37°C) antibiotic-free DMEM containing 500μM
of HCK. To make the UAA-containing media, dilute 10μL of a

50mM stock of HCK in DMSO into 890μL of antibiotic-

free DMEM

3.3.5 For each designatedwell, combine 800ng of pE323-HCKRS (Fig. 2),

800ng of pUb-X-EGFP-P2A-mCherry (from Section 3.1), and 8μL
of LPEI (1mg/mL), then add Opti-MEM for a final volume of

100μL. Allow the mixture to incubate at room temperature for

10min, then gently add 100μL of the transfection mix dropwise to

each well

3.3.6 Incubate the plate for 24h at 37 °C and 5% CO2

3.3.7 Remove the media and wash the cells with 500μL of prewarmed

(37 °C) PBS, incubating each wash for 10min at room temperature.

Repeat for a total of three PBS washes

3.3.8 To the washed cells, add 990μL of fresh phenol red-free DMEM

with 10% fetal bovine serum and without antibiotics. Expose the

appropriate wells to light by irradiating the plate with 365nm light

for 3min (VWR Dual Transilluminator, 25mW/cm2) through the

bottom of the plastic plate, about 3mm below the cells. Use alumi-

num foil to shield non-irradiated wells from light exposure

275An N-terminal 14 amino acid degron enables optical control of protein degradation



3.3.9 After irradiation, add 10μL of cycloheximide (5mg/mL in water) to

each well to inhibit further protein expression, then incubate the

plate overnight at 37 °C with 5% CO2

3.3.10 The following day, wash each well once with 500μL of ice-cold

PBS to remove residual DMEM

3.3.11 For each well, dilute 1.5μL of 100� protease inhibitor cocktail into

149μL of ice-cold RIPA buffer. Lyse the cells by adding 125μL of

the lysis buffer directly to the well then shake the plate on ice at

250rpm for 15min. Transfer the lysates to 1.7mL microcentrifuge

tubes and pellet the cell debris through centrifugation (13,000 g for

10min)

3.3.12 Combine 60μL of the lysate with 20μL of 4� SDS-PAGE sample

loading buffer and heat the samples at 95 °C for 10min

3.3.13 Load 11μL of each sample onto two duplicate 10% v/v SDS-PAGE

gels and separate via electrophoresis (60V for 20min, 150V for

100min, or until the dye front runs off the gel)

3.3.14 Transfer the separated proteins from each gel to a PDVF membrane

via protein transfer (80V for 2h) in ice-cold 1� transfer buffer

*Keep transfer cold throughout by placing chamber in a large ice

bath*
3.3.15 Block the membrane by rocking with 5mL of 5% milk in TBST at

room temperature for 2h

3.3.16 Make the antibody solutions by diluting rabbit pAb anti-GFP (2μL)
or rabbit pAb anti-GAPDH (2μL) in TBST (4mL, each solution).

Replace the blocking buffer with the antibody solution and incu-

bate overnight at 4 °C with rocking

3.3.17 Wash out the primary antibody by replacing the buffer with 5mL of

fresh, ice-cold TBST and incubating for 10min at room tempera-

ture with rocking. Repeat for a total of three washes

3.3.18 Make a master mix of the secondary antibody solution by diluting

2μL of the anti-rabbit IgGHRP-linked secondary antibody in 5mL

of TBST. Incubate each blot in 5mL of the solution for 1h at room

temperature with rocking

3.3.19 Wash out the secondary antibody by incubating the membrane with

5mL of fresh, ice-cold TBST for 10min at room temperature with

rocking. Repeat for a total of three washes

3.3.20 Develop the blots with SuperSignal West Pico Chemiluminescent

Substrate by mixing 2mL of the luminol/enhancer solution with
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2mL of the peroxide solution and incubating the membrane in the

resulting mixture with rocking at room temperature for 5min

3.3.21 Image the blots using a BioRad ChemiDoc system with automated

exposure times. Use the Cy5 and Cy3 channels to detect the

PageRuler Pre-stained Protein Ladder, and the Chemi channel to

detect the chemiluminescent substrate. A representative western

blot of XDeg-EGFP-P2A-mCherry is shown in Fig. 3

3.4 Live cell fluorescence imaging of optically controlled XDeg-
EGFP-P2A-mCherry

Timing: 3–4 days

3.4.1 Grow cells to 80–90% confluency in a PDK treated 96-well (see step

3.4.1, adding 50μL of diluted PDK (0.1mg/mL) to the 60 internal

wells of the plate), clear bottom plate

3.4.2 For wells where the cells will express proteins without a TAG

mutant, aspirate the old media and replace it with 90μL of fresh,

prewarmed (37 °C) antibiotic-free DMEM

3.4.3 For wells where cells will be transfected with plasmids containing a

TAG mutation, aspirate the old media and replace it with 90μL of

prewarmed (37 °C) antibiotic-free DMEM supplemented with

50μM HCK (dilute 1μL of a 50mM HCK stock solution in

DMSO into 89μL of antibiotic-free DMEM)

Fig. 3 Western blot analysis of pUb-X-EGFP-P2A-mCherry. In comparison to wild type
(WT) pEGFP-HA, N-terminal alanine (A) represents a negative control for the N-end path-
way. The destabilizing N-terminal lysine (K) is used as a positive control for degradation.
HCK decaging and protein stability can be directly compared with and without UV irra-
diation. Caging of the N-terminal lysine of pUb-optoDeg-EGFP-P2A-mCherry prevents
recognition by an E3 ligase and degradation of the protein via the N-end pathway.
Irradiation and subsequent decaging of pUb-optoDeg-EGFP-P2A-mCherry yields the
destabilizing N-terminal lysine and resultant protein degradation comparable to the
positive control.
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3.4.4 For each designated well, combine 100ng of pE323-HCKRS

(Fig. 2), 100ng of pUb-X-EGFP-P2A-mCherry (Section 3.1),

1μL of LPEI (1mg/mL) in Opti-MEM for a final volume of

10μL. Allow the mixture to incubate at room temperature for

10min, then gently add 10μL of the transfection mix dropwise

to the specified well

3.4.5 Incubate the plate for 24h at 37°C and 5% CO2

3.4.6 Aspirate the media and wash the cells with 50μL of prewarmed

(37°C) PBS, incubating each wash for 10min. Repeat for a total

of three PBS washes for each well

3.4.7 Add 90μL of fresh live cell imaging solution (LCIS) to each well

3.4.8 Prepare the microscope by setting up the Tokai Hit incubated stage

with a blank plate using the following settings: 5% CO2 and 37 °C.
Add �25mL of water to the insulating jacket and turn on the

CO2 regulator. Allow the apparatus to equilibrate for 10–15min.

Then, carefully place the experiment plate in the incubated stage

and cover it with the lid. Allow the final assembly to equilibrate

for another 5–10min

3.4.9 Select and save three distinct fields of view within a single well, for

each of the conditions being analyzed: pUb-K-, pUb-A-, or pUb-

optoDeg-EGFP-P2A-mCherry. Image the cells for initial timepoints

before irradiation using the DsRed and FITC filter sets. Export the

images as JPEG files

3.4.10 Leaving the plate inside the incubated stage and being careful not to

move it, irradiate the designated optoDeg wells with a 405nm LED

(700mA) for 15 s from the top of the well (about 12mm directly

above the cells). Use aluminum foil to block wells that are not irra-

diated. Immediately image the cells (with the same saved positions

and filters from step 3.5.9) and export the file as a JPEG file

*Be sure to wear proper UV safety glasses for the duration of

irradiation.*
3.4.11 Image the cells at 10, 20, and 30min post-irradiation. Export the

image files as JPEG files

3.4.12 To determine the extent of degradation over time, process the

images in ImageJ. Open the mCherry image in two separate win-

dows. Apply a mask based on the mCherry fluorescence to remove

background
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OnMacOS: Open the Threshold Color Panel (control+shift+T).

Leaving the Hue and Saturation parameters unchanged, slide the

top Brightness bar all the way to zero (left), then adjust the bottom

brightness bar until all fluorescent cells, including the lighter con-

trast cells, are visible. This will create the threshold. To outline cells

expressing mCherry at or above the specified threshold, click Select

in the Threshold Color Panel. To create a mask based on the applied

threshold, go to Process>Binary>Convert to Mask. Once gener-

ated, outline the mask by going to Edit>Selection>Create

Selection. Copy the generated outline (command+C) and paste

(command+V) it onto the mCherry and EGFP images of the same

position. Click and drag the outline to adjust the position if needed.

Calculate the mean fluorescence (mean gray value) in the designated

outline by clicking inside one of the highlighted cells (the yellow

outline will disappear), then press “m.” A window will appear

and populate with the data for the selected image. To save and ana-

lyze the data, copy it from the results window and paste it an Excel

spreadsheet or other analysis software

On PC: Open the Threshold window (control+shift+T) and

slide the top brightness bar all the way to the left, then adjust the

bottom brightness bar until all fluorescent cells, including the lighter

contrast cells, are visible. Make sure the “Dark background,” “Stack

histogram,” and “Don’t reset range” boxes remain unchecked and

click Apply. This will create a mask based on the applied threshold

for cells expressing mCherry. To outline the mask, go to Edit>
Selection>Create Selection. Copy and paste the selection onto

the mCherry and EGFP images of the same position. Pasting will

yield the outlines filled in with black, so remove the outline by

clicking within the bounds of a cell. To calculate the mean fluores-

cence in the outline, go to Results>Mean Gray Value, then press

“m” and a windowwill open with the calculated mean fluorescence

of the outlined area. Copy and paste the data into an Excel spread-

sheet or other software to save and analyze

For single cell analysis: After applying the mask to both images, for

PC, synchronize the mCherry and EGFP windows by going to

Analyze>Tools>Synchronize Windows and selecting the file

names associated with the mCherry and EGFP images. Ensure that
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“Sync cursor” is checked. For MacOS, open both mCherry and

EGFP windows, then synchronize by opening Analyze>Tools>
Synchronize Windows, selecting only “sync cursor” then clicking

“Synchronize All.” Select a single cell in the mCherry channel

and outline with the Freehand selections tool on ImageJ. This will

simultaneously outline the same area in the EGFP image. Calculate

the mean fluorescence of the outlined cell by keying “m” on both

images and copy the populated data into an Excel spreadsheet or

other software. Using this data, calculate the EGFP/mCherry ratio.

Repeat this process for 100 cells between 9 fields of view through

each of the three replicate wells

3.4.13 Calculate the standard deviation from the values generated from

analyzing 100 cells

3.4.14 Calculate the statistical significance with a two-way ANOVA test

comparing the mean EGFP/mCherry fluorescence values from

each sample over different time points. Representative single cell

analyses of light titration of XDeg-EGFP-P2A-mCherry is shown

in Fig. 4

Fig. 4 XDeg-EGFP-P2A-mCherry fluorescence pre- and post-irradiation. (A) EGFP fluo-
rescence relative to mCherry. p <0.0001 from two-way ANOVA between HCK (+UV)
and HCK (�UV) at t ¼ 30min. (B) Single cell analysis of EGFP fluorescence relative to
mCherry internal control. Cells binned according to percent decrease in EGFP intensity
relative to pre-irradiation intensity. A¼ADeg-EGFP-P2A-mCherry; K¼KDeg-EGFP-P2A-
mCherry; HCK¼optoDeg-EGFP-P2A-mCherry. Analysis via fluorescence images of
optoDeg-EGFP-P2A-mCherry demonstrates rapid protein degradation following
decaging, with �65% EGFP degradation observed after one irradiation and 85% after
two or three further irradiations (A). The efficiency of degradation is inversely correlated
to the initial protein levels, where cells expressing the lowest amount of optoDeg-
EGFP-P2A-mCherry exhibited the highest degradation efficiency (B).
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3.5 Validation of XDeg-caMEK1-HA expression through
western blot

Timing: 6–7 days

3.5.1 Follow the same steps used in Section 3.3 to express pUb-X-

caMEK1-HA in HEK293T cells and analyze the resultant protein

stability with and without irradiation via western blot. Use pUb-

K-caMEK1-HA and pUb-A-caMEK1-HA as positive and negative

controls for degradation, respectively

3.5.2 Probe the resulting blots with primary antibodies: rabbit pAb anti-HA

(2μL), or rabbit pAb anti-GAPDH (2μL) in TBST (4mL, each

solution). A representative western blot of XDeg-caMEK-HA is

shown in Fig. 5

3.6 EGFP-ERK2 translocation assay
Timing: 3–4 days

3.6.1 Grow NIH 3T3 cells to 80–90% confluency in a PDK-treated

(see step 3.5.1) black, clear-bottom 96-well plate

3.6.2 For wells where cells have been transfected with plasmids without

a TAG mutation, aspirate the media and replace it with 90μL of

prewarmed (37 °C) antibiotic-free DMEM

3.6.3 For wells where cells have been transfected with plasmids con-

taining a TAG mutation, aspirate the old media and replace it with

90μL of prewarmed (37°C) antibiotic-free DMEM supplemented

with 500μM HCK (dilute 1μL of 50mM HCK stock solution in

DMSO into 89μL of antibiotic-free DMEM)

3.6.4 Transfect each well with 75ng of pE323-HCKRS (Fig. 2) and 25ng

of pEGFP-ERK2 (Fig. 2) with or without 100ng of pUb-X-

caMEK1-P2A-mCherry (from Section 3.2), using Lipofectamine

Fig. 5 Western blot analysis of XDeg-caMEK1-HA stability. N-terminal alanine
(A) represents a negative control for the N-end pathway. The destabilizing
N-terminal lysine (K) is used as a positive control for degradation. HCK decaging and
protein stability can be directly compared with and without UV irradiation. A- and
optoDeg-caMEK1-HA are expressed as stable proteins, while decaging of optoDeg-
caMEK1-HA yields complete protein degradation, comparable to the positive control.
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3000. For each well, prepare twomicrocentrifuge tubes. To tube A,

add 5μL of Opti-MEM,DNA (totaling 200ngDNA), and 0.4μL of
P3000. To tube B, add 5μL of Opti-MEM and 0.4μL of Lipo3000.

Flick each tube to mix, then spin down, and incubate the mixture

for 5min at room temperature. Add tube A to tube B (order of addi-

tion is important). Mix by slowly pipetting up and down only one

time. Allow the mixture to incubate at room temperature for

20min, then add the mixture dropwise to the specified well

3.6.5 Incubate the transfected cells for 36h at 37 °C and 5% CO2

3.6.6 Wash the cells with 50μL of prewarmed (37 °C) PBS, incubating for
10min. Repeat for a total of three washes

3.6.7 Serum starve the cells by replacing the media with 90μL of

prewarmed (37 °C) LCIS. Incubate for 6h at 37 °C with 5% CO2

3.6.8 Prepare the microscope and Tokai Hit incubated stage as described

in step 3.5.8

3.6.9 Select and save three fields of view per well for each pUb-X-

caMEK1-P2A-mCherry mutant. Once positions are selected, the

plate should not be moved so as to preserve the precise fields of view

throughout the experiment

3.6.10 Image cells for initial values using the DsRed and FITC filter sets

20min before starting the experiment

3.6.11 Without removing the plate from the stage, stimulate cells

expressing the reporter-only control by adding 10μL of FGF

(1μg/mL in LCIS) to the appropriate wells

3.6.12 Treat the specified wells with light by irradiating the wells from the

top with a 405nm LED (700mA) for 1min (about 12mm directly

above the cells), as described in step 3.5.10. Use aluminum foil to

protect non-irradiated wells

*Be sure to wear proper UV safety glasses for the duration of

irradiation.*
3.6.13 Image the cells at 20min intervals following the initial irradiation,

up to 80min. Representative micrographs are shown in Fig. 6

3.7 Quantification of nuclear localization for XDeg-caMEK1
Timing: 1–2h
3.7.1 After imaging the cells over the designated period of time (80min),

export the images as JPEG files to analyze in ImageJ
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3.7.2 To determine the ratio of nucleus to cytoplasm localization (N/C

ratios), first create a selection using the Oval Selection tool within

the appropriate subcellular region—nucleus or cytoplasm. Outlined

areas should be between 200 and 1000μm2

3.7.3 Measure the mean fluorescence intensity of the outlined area by

pressing “m” and populating a results window with the calculated

mean. Copy and paste the results into a spreadsheet and average

the individual N/C values. A representative quantification of

EGFP-ERK2 localization via XDeg-caMEK1-P2A-mCherry activity

is shown in Fig. 7

3.7.4 Determine the standard error of the mean from 10 individual cells

from three biological replicates

3.7.5 Calculate the statistical significance with a two-way ANOVA test

comparing N/C values of each sample across different time points

Fig. 6 Representativemicrographs of XDeg-caMEK1-P2A-mCherry expressed in NIH 3T3
cells. The stable ADeg- and optoDeg-caMEK1-P2A-mCherry (�UV) fusion proteins are
enzymatically active as seen by translocation of EGFP-ERK2 to the nucleus. The unstable
KDeg-caMEK1-P2A-mCherry, however, results in cytoplasmic localization of the
EGFP-ERK2 reporter since the Ras/MAPK signaling pathway is not activated.
optoDeg-caMEK1-P2A-mCherry (+UV) shows the translocation of the reporter from
the nucleus, back to the cytoplasm over 80min post irradiation (arrow).
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4. Safety considerations and standards

Common security measures for a biosafety level-2 laboratory must be

followed, including waste disposal. Personal protective equipment: safety

glasses, lab coat, and nitrile gloves are required for performing experiments.

Sterile techniques should be maintained while using a laminar flow tissue

culture hood. Cells should be used between passage number 3 and 26.

Cell lines should be tested for mycoplasma contamination every 6 months.

Eye protection should be worn during irradiation experiments.

5. Summary

An optically controlled N-degron, termed optoDeg, was generated

through incorporation of a photocaged amino acid, HCK, at the endoge-

nously exposedN-terminus of a POI. The optoDeg allows for light-mediated

induction of POI degradation with complete temporal control, excellent deg-

radation efficiency and kinetics, and design flexibility that requires minimal

protein engineering. Here, we describe the methods for applying the

optoDeg to two distinct proteins, the fluorescent protein EGFP and the kinase

MEK1. The acute triggering of target protein degradation upon irradiation

(365nm or 405nm) is analyzed by fluorescence imaging and western blots.

Fig. 7 Quantification of nuclear vs cytoplasmic (N/C) localization of EGFP-ERK2 over an
80min time-course in 10 cells for each condition. The entire experiment was repeated in
triplicate. (A) Negative control ADeg-caMEK1-P2A-mCherry and positive control KDeg-
caMEK1-P2A-mCherry co-expressed with the EGFP-ERK2 reporter without external stim-
ulation. (B) Time-course quantification of N/C ratio for cells expressing optoDeg-
caMEK1-P2A-mCherry with the EGRP-ERK2 reporter 20min before and up to 80min after
irradiation, compared to non-irradiated optoDeg-caMEK1-P2A-mCherry. Light-induced
degradation of optoDeg-caMEK1 stopped phosphorylation and subsequent nuclear
translocation of the EGFP-ERK2 reporter, thus restoring cytoplasmic localization with
N/C ratios similar to the positive control, the unstable KDeg-caMEK1.
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Utilizing the methods described here, any protein of interest tolerating a small

N-terminal peptide tag can be engineered with the optoDeg for precise spa-

tiotemporal control. We expect our optoDeg to aid in the investigation of

dynamic cell signaling networks and the molecular mechanisms that govern

cellular processes such as development and proliferation. Genetic code expan-

sion has been achieved in animals (Brown, Liu, & Deiters, 2018), which

further broadens the utility of optoDeg.
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